# Introduction to MATLAB

MBL Physiology Course  
Summer 2008

Mike Springer  
michael_springer@hms.harvard.edu
Hao Yuan Kueh  
kueh@fas.harvard.edu
Zeba Wunderlich  
wunder@fas.harvard.edu
Andy Hilfinger  
andreas_hilfinger@hms.harvard.edu

<table>
<thead>
<tr>
<th>1 GOALS AND LOGISTICS</th>
<th>2 COMBAT HELP</th>
<th>3 WHAT YOU SEE WHEN YOU OPEN MATLAB</th>
<th>4 VARIABLES, ARRAYS &amp; FUNCTIONS</th>
<th>5 PLOTTING</th>
<th>6 WRITING SCRIPTS AND FUNCTIONS</th>
<th>7 LOOPS AND FLOW CONTROL</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1 GOALS AND LOGISTICS</td>
<td>2.1 MATLAB HELP</td>
<td>3.1 What you see when you open MATLAB</td>
<td>4.1 Variables</td>
<td>5.1 Basic Plotting</td>
<td>6.1 Scripts</td>
<td>7.1 For Loop</td>
</tr>
<tr>
<td>1.2 LOGISTICS</td>
<td>2.2 MATLAB HELP</td>
<td>3.2 What you see when you open MATLAB</td>
<td>4.2 Arrays</td>
<td>5.2 2D Plotting</td>
<td>6.2 Functions</td>
<td>7.2 If Statement and Logical Operators</td>
</tr>
<tr>
<td>1.3 Goals and Logistics</td>
<td>2.3 MATLAB HELP</td>
<td>3.3 What you see when you open MATLAB</td>
<td>4.3 Built-In MATLAB Functions</td>
<td>5.3 Exercise 2</td>
<td>6.3 Exercise 3</td>
<td>7.3 Elseif and Else Statements</td>
</tr>
<tr>
<td>1.4 Goals and Logistics</td>
<td>2.4 MATLAB HELP</td>
<td>3.4 What you see when you open MATLAB</td>
<td>4.4 Exercise 1</td>
<td>5.4 Plotting Command Reference Card</td>
<td>6.4 Exercise 4</td>
<td>7.4 While Loop</td>
</tr>
<tr>
<td>1.5 Goals and Logistics</td>
<td>2.5 MATLAB HELP</td>
<td>3.5 What you see when you open MATLAB</td>
<td>4.5 Basic Command Reference Card</td>
<td>5.5 Plotting Command Reference Card</td>
<td>6.5 Plotting Command Reference Card</td>
<td>7.5 Random Number Generator</td>
</tr>
<tr>
<td>1.6 Goals and Logistics</td>
<td>2.6 MATLAB HELP</td>
<td>3.6 What you see when you open MATLAB</td>
<td>4.6 Functions</td>
<td>5.6 Exercise 4</td>
<td>6.6 Exercise 5</td>
<td>7.6 Break and Continue Commands</td>
</tr>
<tr>
<td>1.7 Goals and Logistics</td>
<td>2.7 MATLAB HELP</td>
<td>3.7 What you see when you open MATLAB</td>
<td>4.7 Variables, Arrays &amp; Functions</td>
<td>5.7 Exercise 4</td>
<td>6.7 Exercise 5</td>
<td>7.7 Exercise 4</td>
</tr>
<tr>
<td>1.8 Goals and Logistics</td>
<td>2.8 MATLAB HELP</td>
<td>3.8 What you see when you open MATLAB</td>
<td>4.8 Functions</td>
<td>5.8 Exercise 4</td>
<td>6.8 Exercise 5</td>
<td>7.8 Flow Control Command Reference Card</td>
</tr>
</tbody>
</table>
1 Goals and Logistics

This is meant to be either a guide during a MATLAB course or a stand alone introductory packet. The goal of this course/packet is to get someone who has never programmed before to be able to read and write simple programs in 6-8 hours.

The Table of Contents is clickable. To get to a certain spot, just click.

Instructions you should type into MATLAB are displayed in \textcolor{red}{red courier font}. You can cut and paste commands in this packet directly into MATLAB.

Outputs that you will see from MATLAB are shown in \textcolor{black}{black courier font}. The output won’t always be included in this document.

Think about the commands you type in and if you understand the output.

The goal is not to get through the packet as quickly as possible. Explore and try things out. It is hard to break a computer.

2 MATLAB Help

There are many ways to access MATLAB help, some of which will be highlighted in the packet.

\begin{itemize}
\item Like most other programs, there is a help menu in the command bar at the top of the screen.
\item If you know the name of the command, type `\texttt{help <command>}` in MATLAB
\item If you don’t know the name of the command, \url{http://www.mathworks.com/access/helpdesk/help/techdoc/matlab.html}
\end{itemize}
3 What you see when you open MATLAB

There are three subsections of this window:

The bottom left corner is the command history. Any time you enter a command into MATLAB it records the command you entered. The time and date that you log in is also recorded. This is a useful way to repeat or view what you did on an earlier date. You can copy and paste this into a different file, or double click a command to repeat it.

The top left corner is the current directory. It tells you where you are in the workspace. This becomes important when you write programs that you will run later. Alternatively if the workspace tab is highlighted, the top left will display all the variables and arrays that you have made and will indicate their current values.

The right subwindow is the command window into which you enter commands.

Often you will store all your files in one directory on you computer. You can change the directory you are in using the buttons just above the command window. We will demonstrate later.
4 Variables, Arrays & Functions

4.1 Variables
Let's start by entering a simple algebraic equation.

>> 2+3
into the command window (rectangle)
You will see that

\texttt{ans = 5}

appears on the screen. In the bottom left screen, the line you typed in appears. In the top left screen the variable \texttt{ans} appears (as shown below).

>> x=3;
This stores the value 3 into the variable \texttt{x}.

>> y=2
\texttt{y = 2}

Notice the difference of including the ‘;’. A ‘;’ suppresses the output of the line. You will almost always want to end your lines with semicolons. For most of this tutorial, the ‘;’ will not be included so one can see the output for instructional purposes.

>> z=x+y;
>> z
\texttt{z = 5}

>> a=z+x*2
4.2 Arrays

Often, you will want to store more than one value in a single variable, e.g. data points in a time series. Arrays or matrices are incredibly useful in these applications. Due to its ability to efficiently work with large matrices, MATLAB actually stands for MATrix LABoratory. An array is just a table of numbers.

Storing multiple values in an array is useful because you can perform some operation on them simultaneously. For example, if we wanted to take the sine of a large number of values, we can store all these values in an array and take the sine with a single command. Like in Excel, individual elements or whole rows or columns can be easily extracted, plotted, or changed.

Entering arrays

>> t=[0 1 2 3 4 5 6 7 8 9]
This creates a variable \( t \), which is a one-dimensional array (or a row vector), with 10 entries.

The colon operator

One can enter the array much more easily by using the colon notation:

>> t=[0:1:9]

\[
\begin{array}{cccccccccccc}
 0 & 1 & 2 & 3 & 4 & 5 & 6 & 7 & 8 & 9 \\
\end{array}
\]

This means make an array starting at 0 stopping when less then or equal to 9 and stepping by 1. In general, \( a:x:b \) means start at \( a \), and step by \( x \) until \( b \) is reached (\( x \) can be negative). The default step size is 1, so \([0:1:9]\) is the same as \([0:9]\).

>> t=[0:9]
>> t=[-2:3:8]
>> t=[0:0.5:2.75]
>> t=[8:1]
>> t=[8:-1:1]

Try your own, and make sure you understand this.

Defining a complete array

>> a=[1 2]
\[
a =
\begin{array}{cccccccccccc}
 1 & 2 \\
\end{array}
\]

Adding elements to a pre-existing array

>> a=[a 3]
\[ a = \begin{bmatrix} 1 & 2 & 3 \end{bmatrix} \]

This adds a 3 to the end of the array.

**Column versus row vectors**

Up until now, we have been working with row vectors – arrays with one row and several columns. In some cases, we will want to work with column vector. In this context, a semi-colon indicates the start of a new row.

\[
\gg a = [1; 2; 3] \\
a = \begin{bmatrix} 1 \\ 2 \\ 3 \end{bmatrix}
\]

This creates a column array with one column and 3 rows.

You can see the variable \( a \) change in value in the upper left window.

To change a row vector to a column vector or vice versa, you can use the transpose operator ‘\(^T\)’.

\[
\gg a^T \\
a = \begin{bmatrix} 1 & 2 & 3 \end{bmatrix}
\]

\[
\gg a = [a \; 4]
\]

This doesn’t work! Right now \( a \) is a 3 row x 1 column array, so we can’t add another column with only 1 entry.

\[
\gg a = [a; \; 4];
\]

This works, now \( a \) is a 4 row x 1 column array.

**Mathematically manipulation of an array**

\[
\gg a*2 \\
a = \begin{bmatrix} 2 \\ 4 \\ 6 \\ 8 \end{bmatrix}
\]

Note the 2* applies to every element of the column vector.
>> a=[a a*2]
a =
  1  2
  2  4
  3  6
  4  8

This works too! Matrix elements can be inserted and manipulated at the same time.

>> a=a+1
a =
  2  3
  3  5
  4  7
  5  9

This applies to every member of the array. Division by a constant (/) and subtraction of a constant (-) also work.

>> x=2;
>> a*x
This multiplies every element of the array by the scalar x.

When an array is multiplied or divided by, or added or subtracted to a scalar (a single number), each element in the array is manipulated in the same way.

Retrieving values from an array
>> a(1,2)
This returns the element that is in the first row, second column of the array a.

In general, a(m, n) retrieves the value in the m-th row, n-th column.

Now you can see one use of the colon notation we learned above. For example, if you have a vector t with time points from an experiment and only want to look at every third time point, you can type t(1:3:end) and you will see every third entry of t.

>> a(1,2)=a(1,2)+1
a =
  2  4
  3  5
  4  7
  5  9

Once again, element retrieval and manipulation can be performed in one line.
This line took the value from the first row, second column of \(a\), added 1 to this value, and then stored it back in array \(a\) in the first row, second column.

\[
\begin{align*}
\gg a(3,1) &= a(3,1) + 1 \\
\gg a(1,3) &= a(1,3) + 1
\end{align*}
\]

You receive an error message because there is no third column.

Errors messages in MATLAB are useful. Take time to read them. They will often let you quickly correct your error.

**Arrays and values are interchangeable**

\[
\gg a(1:2,1) = a(2,2)
\]

Remember 1:2 means \([1 2]\) or 1 and 2. This replaces the first and second row of the first column with the value in \(a(2,2)\).

This is the real power of MATLAB. You can use values, an array, or even a function (which will hopefully return an array or value) interchangeably. MATLAB handles it correctly.

\[
\gg a(:,2) = 0
\]

This replaces every row in the second column with zeros.

Here the colon notation is equivalent to 1:end. When you define an array you use \([\,]\); when you call a position in an array you use ().

**Matrix manipulation continued**

\[
\begin{align*}
\gg a &= [1 \ 2; \ 3 \ 4] \\
\gg b &= [2 \ 4; \ 3 \ 3] \\
\gg c &= a + b
\end{align*}
\]

This adds the elements of the matrices that are in identical positions, which is called an element-wise operation. This will only work if the dimensions of \(a\) and \(b\) match – they have the same number of rows and columns.

This is equivalent to the more laborious:

\[
\begin{align*}
c(1,1) &= a(1,1) + b(1,1) \\
c(1,2) &= a(1,2) + b(1,2) \\
c(2,1) &= a(2,1) + b(2,1) \\
c(2,2) &= a(2,2) + b(2,2)
\end{align*}
\]

Addition and subtraction are always element-wise operations. However, division, multiplication and exponentiation (^) are not. This is because there are special
definitions for these operations with matrices (linear algebra). However, to perform, e.g.
element-wise multiplication, you can use the dot operator.

```matlab
>> c=a.*b
ans =
    1     4
    9    16
```

This multiples each element of the array `a` by the equivalent element in array `b`, or:

```matlab
c(1,1)=a(1,1)*b(1,1);
c(1,2)=a(1,2)*b(1,2);
c(2,1)=a(2,1)*b(2,1);
c(2,2)=a(2,2)*b(2,2);
```

In contrast, when we multiply two matrices together using `*` without the preceding dot,
we carry out matrix multiplication.

```matlab
>> a*a
ans =
    7    10
   15    22
```

This performed the matrix multiplication of `a` by `a`.

### 4.3 Built-In MATLAB Functions
MATLAB has many built in functions that are useful for calculations.

```matlab
>> sin(2*pi)
```

Functions can be performed on variables as well as on numbers.

```matlab
>> t=2*pi;
>> sin(t)
```

Function call are always of the form

```
NAME_OF_FUNCTION(VALUE_TO_PERFORM_FUNCTION_ON)
```

Like variables, functions are an incredible useful organization tool and we will come
back to them repeatedly.

There are a bunch of useful built in functions in MATLAB. You can often guess at the
name (for example mean calculates the mean; median finds the median). This short list is
meant to give you a feeling for how the functions work.

To see if a function exists, type the first couple letters and press ‘tab’. A list of functions
that have names starting with those letters will appear. For example, type `sin ‘tab’`. This trick also works for variable names.
Try typing these in and think about what you would expect the to do.
Here are a bunch of useful functions:

>> length(a) %gives you the length of the longer dimension
>> size(a) %gives you the length of all the dimensions of the array
back as a n- element array)
>> length(a(:,1)) %gives you the length of the column
>> n=1
>> size(a,n) %gives you the length of the nth dimension of a
>> length(a(1,:)) %gives you the length of the row
>> a(end) %gives you the last element of the array
>> max(a) %gives the maximum number in each column
>> max(max(a)) %gives the maximum number in whole array

>> a(:) %linearize an array – in other words make the whole array
into one long column
>> max(a(:)) %gives the maximum number in whole array
>> min(a) %gives the minimum number in each column

>> a=1:1.1:10
>> floor(a) %rounds down to the nearest integer
>> ceil(a) %rounds up to the nearest integer
>> round(a) %rounds to the closest integer

>> n=2
>> m=3
>> a=eye(n) %makes an array of dimension n where all value are zero
except on the diagonal where they are equal to 1.
>> a=eye(m,n) %same as above except the array in m by n

>> a=zeros(m,n) %makes an array of zeros m by n
>> a=ones(m,n) %makes an array of ones m by n
4.4 Exercise 1

1. A is the 10 by 10 matrix:

\[
\begin{bmatrix}
58 & 20 & 41 & 21 & 68 & 45 & 60 & 8 & 12 & 23 \\
42 & 37 & 30 & 64 & 21 & 4 & 1 & 45 & 45 & 23 \\
51 & 78 & 87 & 32 & 83 & 2 & 1 & 44 & 71 & 4 \\
33 & 68 & 1 & 96 & 62 & 31 & 19 & 35 & 89 & 7 \\
43 & 46 & 76 & 72 & 13 & 1 & 58 & 15 & 27 & 64 \\
22 & 56 & 97 & 41 & 20 & 38 & 5 & 67 & 25 & 19 \\
57 & 79 & 99 & 74 & 60 & 68 & 36 & 69 & 86 & 84 \\
76 & 5 & 78 & 26 & 62 & 9 & 63 & 72 & 23 & 17 \\
52 & 60 & 43 & 43 & 37 & 3 & 71 & 47 & 80 & 17 \\
64 & 5 & 49 & 93 & 57 & 61 & 69 & 55 & 90 & 99
\end{bmatrix}
\]

What will \( A(9:-2:3,1:6:5) \) return?

The following should be achievable in one line of code:

2. Create a, a 10 by 10 array where all values are zero except along the diagonal where all values equal 5. (Try using the functions we’ve learned; don't just type in all the values).

3. Take double the value of the element in the fourth row, fourth column of the array a, and add it to the whole sixth row and eighth row of the array a.

4. Save a new array b as the array a to the power of the value in the fourth row, fifth column.

5. What is the average value of each column, using only every third row of the array a? What is the average value of each row, using only every third row of the array a?

6. Concatenate (join together) array a and b to make an array of 20 rows and 10 columns.
4.5 Basic Command Reference Card

• Some basic syntax
  o Defining a variable: \( x = 2 \)
  o Defining a vector \([1 \hspace{0.5cm} 3 \hspace{0.5cm} 5]\): \( y = [1 \hspace{0.5cm} 3 \hspace{0.5cm} 5] \)
  o Defining a matrix \([\begin{array}{cc} 1 & 2 \\ 3 & 4 \end{array}]\): \( z = [1 \hspace{0.5cm} 2; \hspace{0.5cm} 3 \hspace{0.5cm} 4] \)
  o Suppressing output: ;
  o Accessing an element in a vector: \( y(2) \) (equals 3)
  o Accessing an element in a matrix: \( z(2, 1) \) (equals 3)
  o Accessing a row/column in a matrix: \( z(2, :) \) (equals [3 4])
  o Accessing elements in a vector that satisfy some condition
    \( y(y>2) \) (equals [3 5])
  o Accessing indices of elements in a vector that satisfy some condition
    \( \text{find}(y>2) \) (equals [2 3])
  o Transposing a vector:
    \( y' \) (equals \( \begin{array}{c} 1 \\ 3 \\ 5 \end{array} \))
  o Mathematical operators: +, -, *, /, ^
  o Element-wise operations: \( 2.\{+,-,\ast,\div,\wedge\}y \)

Note the dot! \( [1 \hspace{0.5cm} 2 \hspace{0.5cm} 3].*y = [1 \hspace{0.5cm} 6 \hspace{0.5cm} 15] \)

• Special numbers (\( \pi, \infty \)):
  o Exponential (\( e^x \)): \( \exp(x) \)
  o Natural logarithm (\( \ln x \)): \( \log(x) \)
  o Trigonometric functions: \( \cos(x), \sin(x), \tan(x), \text{etc.} \)
  o Absolute value (\( |x| \)):
    \( \text{abs}(x) \)

• Some basic commands
  o Ways to make vectors:
    ▪ Equally spaced intervals: \( x = 1:0.5:3 \) (equals \( [1 \hspace{0.5cm} 1.5 \hspace{0.5cm} 2 \hspace{0.5cm} 2.5 \hspace{0.5cm} 3] \))
    ▪ All zeros: \( x = \text{zeros}(1, n) \) (equals \( n \text{ zeros} \))
    ▪ All ones: \( x = \text{ones}(1, n) \) (equals \( n \text{ ones} \))
  o Draw \( n \) uniformly distributed random numbers between 0 and 1
    \( \text{rand}(1, n) \)
  o Minimum of vector
    \( \text{min}(y) \)
  o Maximum of vector
    \( \text{max}(y) \)
  o Sum of vector
    \( \text{sum}(y) \)
  o Mean of vector
    \( \text{mean}(y) \)
  o Variance of vector
    \( \text{var}(y) \)
  o Size of vector
    \( \text{size}(y) \)
  o Length of vector
    \( \text{length}(y) \)
5 Plotting

5.1 Basic Plotting
MATLAB has powerful tools for plotting and visualizing data. In this example, we will plot a sine wave in a separate figure.

Let’s first define the sine wave:

```
>> t=0:0.1:9
>> t=t*pi/9*4
>> b (up arrow key)

The up arrow key fills in the last command line starting with the letter b (very useful). If you leave off the ‘b’, using the up arrow will scroll through the command history.
```

```
>> b=sin(t)

>> plot(t, b);
```

Here we are plotting the values of \( b \) (y-axis) versus the values of \( t \) (x-axis).

**Your version of MATLAB may show something slightly different.**

It is probably worth examining the different options for several minutes. Check out the menu options.

To edit the properties of the figure, choose the arrow tool and then double click in the white space of the graph (see below).
The Property Editor will appear:

![Property Editor screenshot]

The three circled areas in the window that will appear are very useful. The tabs let you change features of each axis. The scale and label are also circled. To change what the line looks like, click on it. The Property Editor will now show properties of the line, and you can change things such as the line thickness.

```matlab
>> c=sin(t*pi/9*2);
>> plot(t, c);
```

This replaces the first plot. If you had closed the plot a new plot would have opened. If there are multiple plots open. This command would plot on the figure that you most recently viewed (not the most recently opened!)

```matlab
>> hold on
```

This will save the first plot when plotting the second.

```matlab
keep pressing up arrow until:
plot(t,b)
appears on the command line
```

Now use the left arrow key to move the cursor and change the line to read:

```matlab
>> plot(t,b,'gx');
```

To see what this does, read the MATLAB help on plot by typing `help plot`.

**Making your plot easier for others to understand**

```matlab
>> legend('value of function');
>> xlabel('x axis');
>> ylabel('y axis');
>> title('my plot');
```
5.2 2D Plotting

```matlab
>> a=0:9;
>> a=a'*a
>> plot(a);
```

This plots each column versus their index numbers (i.e. 1:10) as a different line.

```matlab
>> figure
>> mesh(a);
```

The `figure` command opens up a new figure window. Compare the values in the array to the 2D plot. The `mesh` command plots the matrix as a 2D surface. The height of each element is given by the value of the array.

```matlab
>> a(10,3)=41;
>> a(8,10)=141;
>> figure, mesh(a);
```

How did this mesh change?

```matlab
>> b=[0 1 2 3 4 5 6 7 8 100]
>> c=b
>> c(10)=20
>> mesh(b,c,a);
```

```matlab
>> figure; surf(a);
```

What’s the difference?

In the last line of input above, we’ve demonstrated one other feature of MATLAB – several commands can be entered on a single line, separated by semi-colons.
5.3 Exercise 2

1. Plot an exponential decay (if you don’t know the exponential function use the MATLAB help to try and help you find it) in cyan with the points demarked by crosses. (You may wish to use the MATLAB help on the plot command.)

2. Create the following array:

```matlab
a =
```

```
1 0 1 0 1 0 1 0
0 1 0 1 0 1 0 1
1 0 1 0 1 0 1 0
0 1 0 1 0 1 0 1
1 0 1 0 1 0 1 0
0 1 0 1 0 1 0 1
1 0 1 0 1 0 1 0
0 1 0 1 0 1 0 1
```

This should take two lines of code. (Don’t just type in the values!)

Plot the array as a surface.
Rotate it until it looks like a checkerboard.

3. Label the z-axis.

5.4 Plotting Command Reference Card

```matlab
plot(y)          plot y as the y-axis, with 1,2,3,… as the x-axis
plot(x,y)        plot y versus x (must have same length)
plot(x,A)        plot columns of A versus x (must have same # rows)
axis equal       force the x- and y-axes of the plot to be scaled equally
title('A Title') add a title A Title at the top of the plot
xlabel('blah')   label the x-axis as blah
ylabel('blah')   label the y-axis as blah
legend('foo','bar') label 2 curves in the plot foo and bar
grid             include a grid in the plot
figure           open up a new figure window
xlim([x1 x2])    set the x-axis limits to [x1 x2]
ylim([y1 y2])    set the y-axis limits to [y1 y2]
```

To copy figures in MATLAB, go to Edit → Copy Figure. (Ctrl-C won’t work.)
6 Writing Scripts and Functions

Sometimes you will want to execute some group of commands repetitively. Instead of typing them over and over again, you can create a script or a function. Both are created in the MATLAB editor, which is a simple text editor.

6.1 Scripts

Scripts are simply a collection of commands, saved in a file (an M-file). Scripts are a good way to write a bunch of commands that you will use over and over again but might want to modify slightly.

To create a new file, go to File → New → M-file
A new window will appear. You can write commands into this window.

```matlab
a=2+4;
b=6;
c=a*b
```

To save this script go to File → Save As... Save your file on the desktop as “First.m”

One important note about writing scripts and functions: where you save the M-file matters! MATLAB only looks in certain folders to find M-files. So once you have saved your file, you must make sure its folder is included in the MATLAB path. To do this, go to MATLAB window and go to File → Set Path... and then click on “Add Folder…” Find the folder where you M-file is saved, click “Ok” and then click “Close.” When MATLAB asks you if you want to save the current path for future sessions, you can click “Close.” You must do this each time you save a function in a new folder.

There are now two ways to run the script. You can click on the run button (circled below):

Or you can call the M-file by it’s name:

```matlab
>> First
```

This command is case-sensitive – it must be exactly the same as the file name. It is also a bad idea to give the script the same name as a variable or built-in function. For example, if you name your script mean.m, it will run instead of the built-in mean function.

In either case, the program runs all three commands one after the other.

Go back to the “First.m” window and change the 6 to a 100

```matlab
>> F↑
```
Adding comments

A good way to make your programs more readable is to add comments. This helps other people to make sense out of what your code; but equally importantly it allows you to figure out what you did when you look at the code a month later. To mark lines in your script that you don’t want to run, place a ‘%’ in front of the line.

%This is a comment.
c=3
c+2
%c*c
c =
   3
ans =
   5

Here c+2 will be evaluated, but c*c will not be evaluated.

Notice the different color of the line following the %. When the program runs, the green lines won’t be executed.

A new feature of MATLAB 7 is the block comment:

{%
These lines will be Commented out.
%}

This will comment out all lines between the first and last lines of the above input.

6.2 Functions

What if you want to create a set of code that you can pass an argument to? (For example, when we type sin(2*pi), 2*pi is the argument to the sine command.) We can do this by writing a function. A function is an M-file that will take some input and return some output (or perform some operation).

Let’s create a function.
This function will add two numbers together (similar to the “+” function).

Functions are also created by writing a set of commands in the editor and saving the file as an M-file, but the first line of the M-file for a function is special.

Open a new M-file and type:

```
function val=myfunction(a,b)
a
b
val=a+b;
```
Save this as myfunction.m (on the desktop).

You MUST save the function by the name that follows the equal sign on the first line of the M-file.

As we mentioned above, the first line of the function M-file is special. We first type “function” to let MATLAB know this is a function. We then type

```
val=myfunction(a,b).
```

Here `val` is the return variable – this is the output of the function. `myfunction` is the name of the function and `a` and `b` are the function arguments. This will become clearer as we use the new function.

Open a new M-file:
This is the M-file that will call our function.
```
x=1;
y=2;
result=myfunction(x,y);
result
```

Save this as FirstFunction.m (on the desktop).

```matlab
>> FirstFunction
```

So what happens when we type `FirstFunction`?
Lines 1 and 2 are straightforward, so let’s look at line three.
How to read a line of code:
- Find the equals sign.
- Calculate everything to the right of the equals sign.
- Store the result in the entry to the left of the equals sign.

When MATLAB hits `myfunction`, it looks for what this might be in this order:
1. Is there a variable named `myfunction`?
2. Is there a file in the current directory (or any other directory in the path) called `myfunction`?
   (The order in which the directories are searched is in the path.)
3. Is there a built-in function called `myfunction`?
4. Gives an error if no match is found.

In this case MATLAB will determine that `myfunction` is a user-written function and will pass it two arguments, the values of `x` and `y` – 1 and 2.

Now `myfunction` takes the value of `x` and stores it in `a`, and then takes the value of `y` and stores it in `b`. So `a =1` and `b = 2`. This is because we wrote `myfunction(a,b)` on the first line of `myfunction.m`.

It then executes all the lines in `myfunction`, so `val = 3`. 
Finally it returns the value of the variable \texttt{val}. This is because we wrote \texttt{val=} on the first line of myfunction.m. Therefore, \texttt{return} will be set to 3.

Understanding the first line of a function:
The first line of the code of the function will always look like this.
1. It will be the word \texttt{function}
2. Followed by the variable to be returned at the end of the function
3. Followed by an equals sign
4. Followed by the name of the function
5. Followed by the input arguments

\textbf{Subfunctions}
In order to organize your code further, you can declare subfunctions inside a function.

Comment out
\texttt{%val=a+b;}
from the myfunction.m code.

At the end of the code type:
\texttt{val=a+mysquare(b);}

\begin{verbatim}
function c=mysquare(b)
c=b*b;
\end{verbatim}

Resave the file.

\texttt{>> FirstFunction}

\textbf{6.3 Exercise 3}
1. Write a function that takes a 4-number row vector and returns it as 2 by 2 array.
2. Make a function that takes two 4-number row vectors converts them into 2 by 2 arrays (sounds like question 1 doesn’t it?) and then performs matrix multiplication on the resulting arrays.
7 Loops and Flow Control
In both scripts and functions, you may want to perform repetitive tasks. Loops can be used to perform repetitive tasks within a program. There are also various “flow control” devices that are useful for structuring programs.

7.1 For Loop
In MATLAB, there are two types of loops, “for” loops and “while” loops. In most cases, a given task can be written in either format, but one is often more convenient than the other. We will start with the for loop, which has three components, the loop statement, the loop body, and the end statement.

Make an M-file
```
a= [0 52 25 231]
for i = a
    i
end
```
Save as loops.m (on the desktop).

```
>> loops
```
In this case, the loop statement indicates that the loop variable \( i \) will be set, one-by-one with each loop iteration (run-through), to the next value in \( a \). The loop body is located between the loop statement and end statement and is executed once per loop iteration. This loop will iterate four times, one for each value of \( a \), printing out the current value of \( i \) at each iteration.

Now that our programs are getting more complicated, it is time to become familiar with the debug function, which can help you figure out what is wrong when your code is not executing as expected.

To use the debugger, after saving the M-file, click on the line just to the left of the text in the code. This should create a stop sign. When you run the program now it will stop at this stop sign. You can now step through the program line by line or run it until the next stop sign, by using the buttons in the text editor tool bar (to see what each does, mouse over the buttons). When the program is stopped you can check the values of all your variables (by mousing over the variable in the code) and even perform operations in the command window. This is very useful for debugging but also for learning.

For loop examples
Make an M-file
```
for x = 1:10
    x*x
end
```
Save as loops2.m

In this example, the loop statement is a bit different. The loop runs through the loop body, starting \( x = 1 \) for the first iteration and incrementing \( x \) by one until \( x \) is equal to 10.

```matlab
>> loops2
```

In these examples, there is only one line of code in the loop body; however, there is no limit on the number of lines that can appear in the loop body.

Make an M-file

```matlab
a=zeros(10,1);
for x=1:length(a)
    a(x)=x*x;
end
a
```

Save as loops3.m

```matlab
>> loops3
```

The construction of the loop statement above is a very useful one. It lets you run through the values of a variable (in this case \( a \)), using the loop variable (\( x \)) as the index (\( a(x) \)).

Make an M-file

```matlab
y=10;
a=[];
for x=1:y
    a(end+1)=[x*x]
end
a
```

Save as loops4.m

```matlab
>> loops4
```

\( a=[]; \) makes an empty array
\( a(end+1) \) specifies the entry after the last entry in \( a \). In a empty vector, this is \( a(1) \). In a 1x1 vector, this is \( a(2) \), and so on.

Make an M-file

```matlab
a= [0 1; 52 2; 25 1; 231 3]
for i = a
    i
end
```
The example above shows that you can loop through an array as well as a vector.

To make the code easier to read, MATLAB’s editor automatically indents the loop body. The indentation doesn’t affect the code’s functioning, but it is useful for understanding code. If your indentation gets messed up, you can have MATLAB indent it correctly by selecting the lines of code you want fixed and typing Ctrl-I (or going to Text → Smart Indent).

7.2 If Statement and Logical Operators

The ‘if’ statement can be used to control the flow of the program and execute a certain set of instructions only if certain criteria are met. Below we demonstrate its use, along with a set of logical operators, operators that check whether certain statements are true.

The logical operator we use in the first example is “==”, the “is equal” operator. If you write the statement a==b, it returns “true” if a and b are equal and “false” otherwise. Below we use this operator with the if statement. The “==” is different that the “=”!

We use the mod (modulus) function below. It takes the form mod(numerator, denominator) and returns the remainder of numerator/denominator. Type help mod for more information.

Make an M-file:

```matlab
a=1:100;
b=[];
for x=1:100
    if (mod(a(x),10)==3) %if statement
        b(end+1)=a(x); %statement body
    end %end statement
end %end for loop
b
```

Save as loops5.m

In this first “for if” loop, we check each element of a to see whether the remainder when divided by 10 is equal to 3. If this is true, the element of a is inserted into b.

>> loops5
The `if` statement checks whether a condition is true. If it is true, it executes the commands in the statement body. The statement body is located between the `if` statement and the `end` statement. Like loop bodies, statement bodies can contain multiple commands.

In this next example we demonstrate more logical operators. The “>” and “<” are the greater than and less than operators, and the “>=” “<=” are the greater than or equals to and less than or equals to operators. They are used just like the equals operator – the statement `a > b` evaluates as “true” if `a` is greater than `b`, and false otherwise.

The “|” operator is the “or” operator. If either the statement before the “|” or after the “|” is true, the statement is considered true.

Make an M-file
```
c=[];
for x=1:100
    if ((a(x)>=91) | (a(x)<9))
        c(end+1)=a(x);
    end
end
c
```
Save as loops6.m

```
>> loops6
```

This example shows two more useful operators. The “~=” operator means “not equal.” The “&” operator means “and”. The statement before and after the “&” must be true for the statement to be true. With the proper use of parenthesis, multiple “and” and “or” statements can be used to make complicated logical tests.

Make an M-file
```
d=[];
for x=1:100
    if ((mod(a(x),10)~=1) & (mod(a(x),10)<2))
        d(end+1)=a(x);
    end
end
d
```
Save as loops7.m

```
>> loops7
```
### 7.3 Elsif and Else Statements

The “elseif” and “else” statements can be used in conjunction with “if” statements to create more complicated program structures.

Make an M-file

```matlab
a=[];
b=0;
for x=1:100
    if mod(x,10)==1
        a(end+1)=x;
    elseif mod(x,10)==2
        a(end+1)=x+100;
    else
        b=b+1; %executed if (mod(x,10)~=1)&(mod(x,10)~=2)
    end
end
a
b
```

Save as loops8.m

The ‘`a(end+1)=x+100`’ is executed if `(mod(x,10)~=1)&(mod(x,10)==2)`. The ‘`b=b+1`’ is executed if `(mod(x,10)~=1)&(mod(x,10)~=2)`.

```
>> loops8
```

### 7.4 While Loop

Like for loops, while loops contain three parts: the loop statement, the loop body, and the end statement. In each iteration, the while loop checks whether the loop statement is true. If it is, it performs the operations in the loop body and again returns to the loop statement to see if it is true. When the statement is untrue, it proceeds to the next bit of code following the end statement.

Make an M-file:

```matlab
x=1;
while (x<100) %loop statement
    x=x*1.3 %loop body
end %end statement
```

Save as loops9.m

```
>> loops9
```

It is easy to make “infinite” while loops – loops that never end. To avoid this, you need to make sure that the “while” statement becomes false at some point. If you accidentally write a program with an infinite loop. Press Ctrl-C to stop it.
7.5 Random Number Generator

Often times, you will need to generate random numbers, e.g. if you want to simulate a stochastic process. The `rand` command creates a random number between 0 and 1. The `rand(m,n)` command generates an m by n array with random numbers. To learn more, type `help rand`. The `randn` command creates a random number normally distributed around 0 with standard deviation of 1. (Type `help rand` for more!)

```
>> A=rand(20,1);
>> A=A*100       %gives random numbers between 0 and 100
>> hist(A)       %creates a histogram of A
```

7.6 Break and Continue Commands

`Break` statements are a good way to get out of while loops if some set of conditions has been satisfied.

Make an M-file

```
y=round(rand(1,100));
x=0;
for i=1:length(y)
    if (y(i)==1)
        x=x+1;
    else
        break;
    end
end
```

Save as loops10.m

```
>> loops10
```

If you don’t want to quit the loop entirely, but instead just want to skip to the next iteration (run-through) of the loop, use the `continue` command.

Replace `break` with `continue`, save the file and run it again to compare the results.

What does x represent in each version of loops10.m?

As we show above, you can nest MATLAB commands, e.g. `round(rand(1,100))`. This takes the output of `rand(1,100)`, a vector with 100 random numbers, and passes it to `round`. To learn more about MATLAB rounding functions type `help round`, `help floor`, `help ceiling`. 

26
7.7 Exercise 4
1. Make a program that randomly picks a number between 1 and 100. If the value is between 1-10 have the program output the number. If the value is between 20-30 have the program output the number plus 100. Otherwise output the value minus 100.

2. Make a program that randomly picks a number between 1 and 100. Use a while loop to find the closest integer less than the random number. Break out of the loop and print the value (should be equivalent to rounding down).

3. In MATLAB, loops are sometimes necessary, but if possible, code runs faster when loops are replaced by vector operations. Can you re-write the loops in this section in vector form?

7.8 Flow Control Command Reference Card

Logical operators
== equal
~= not equal
> greater than
< less than
>= greater than or equal to
<= less than or equal to
| or
& and
 xor exclusive or (returns true if ONLY one of the two statements is true)

Loop control statements
for to start a for loop, e.g. for i=1:10
while to start a while loop, e.g. while (x<10)
end to enclose a loop body
break exits the loop
continue moves to the next loop iteration

We also learned how to use if, elseif, and else statements in this section.